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About This User Manual

General

This user manual describes how to operate PLC Connect functions.

Document Conventions
Microsoft Windows conventions are normally used for the standard presentation of 
material when entering text, key sequences, prompts, messages, menu items, screen 
elements, and so on.

Warning, Caution, Information, and Tip Icons
This publication includes Warning, Caution, and Information where appropriate 
to point out safety related or other important information. It also includes Tip to 
point out useful hints to the reader. The corresponding symbols should be 
interpreted as follows:

Any security measures described in this User Manual, for example, for user 
access, password security, network security, firewalls, virus protection, etc., 
represent possible steps that a user of an 800xA System may want to consider 
based on a risk assessment for a particular application and installation. This risk 
assessment, as well as the proper implementation, configuration, installation, 
operation, administration, and maintenance of all relevant security related 
equipment, software, and procedures, are the responsibility of the user of the 
800xA System.

Electrical warning icon indicates the presence of a hazard which could result in 
electrical shock.
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Although Warning hazards are related to personal injury, and Caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
fully comply with all Warning and Caution notices.

Terminology
A complete and comprehensive list of Terms is included in the System 800xA 
Extended Automation (3BDS100972*). The listing included in Engineering 
Concepts includes terms and definitions as they that apply to the 800xA system 
where the usage is different from commonly accepted industry standard definitions 
and definitions given in standard dictionaries such as Webster’s Dictionary of 
Computer Terms.

Related Documentation
A complete list of all documents applicable to the System 800xA Extended 
Automation System is provided in Released User Documents (3BUA000263*). This 
document lists applicable Release Notes and User Instructions. It is provided in 
PDF format and is included on the Release Notes/Documentation media provided 
with your system. Released User Documents are updated with each release and a 
new file is provided that contains all user documents applicable for that release with 

Warning icon indicates the presence of a hazard which could result in personal 
injury.

Caution icon indicates important information or warning related to the concept 
discussed in the text. It might indicate the presence of a hazard which could 
result in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.

Tip icon indicates advice on, for example, how to design your project or how to 
use a certain function
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their applicable document number. Whenever a reference to a specific instruction is 
made, the instruction number is included in the reference.
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Section 1 Introduction

Welcome to PLC Connect
PLC Connect is a connectivity option to System 800xA that makes it possible to 
connect and integrate any type of remote or local installed PLC, RTU or other type 
of device. The information from the connected unit can be treated in the same way 
as information from other 800xA System connectivity.

PLC Connect includes the following:

• Object-oriented PLC Server with alarm detection for boolean, integer and real 
values, data processing and scaling functions. Object types include composite 
process object types and extended signal types.

• Basic integration of connected PLCs and RTUs.

• Built in protocols for Comli, SattBus, Modbus Serial and Modbus TCP/IP.

• Dialed communication (Option) for Comli and Modbus Serial.

• OPC DA (1.0 and 2.05a) client functionality.

• Upload of OPC server configuration.

• Configuration data stored in Aspect Directory.

• Support for Bulk Data Manager.

• Support for multiple control networks, that is, multiple connectivity servers in 
separate PCs in one system.

• Support for redundant connectivity servers with PLC/OPC Server 
communication surveillance.

• Handling of calculated softpoints.

• Open interfaces for calculations, and other client applications.
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Release Information

Read the Release Notes for information concerning the specific release of 
Product_Name. 
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Section 2  Process Graphics

Process graphics are used to show a representation of a process, including current 
states. Via the graphics, it is possible to interact with and control the actual process. 

Warning Levels
The warning levels are shown in Table 1:  

If there is more than one warning for a signal, the top priority warning level will 
be displayed. The same is valid when a summarized warning level is shown for 
the signals in a process object.

Table 1. Warning Levels 

Priority Appearance Description

1 (Top) Communication error, that is, 
communication is down between PLC 
Connect and a connected PLC or OPC 
server.

2 The signal status of the value is uncertain. 
The reason can be, for example:

• Value has not yet been updated from its 
source.

• Value has moved outside its configured 
range.

3 The signal is control disabled.

4 The signal value is forced, that is, it is 
locked locally in Product_Name.
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Configuration of PLC Connect Graphic Elements
This section includes a few examples to illustrate the usage of different PLC 
Connect Graphic Elements and Controls.

Creating Graphic Element Aspects

1. Select an object type in the Object Type Structure as shown in Figure 1.

2. Right-click and select New Aspect from the context menu.

3. Select Graphic Element PG2 aspect category.

4. Enter a name for the graphic element and click Create.

5 (Lowest) No warning 2 (Invisible, Normal state in

run-time when no warning exists)

6 No warning 1(Used to design-time when no 
warning exists) 

Table 1. Warning Levels (Continued)

Priority Appearance Description
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Editing a Graphic Element in Graphics Builder

Execute the following steps to add a symbol factory symbol to the graphic aspect.

1. In the Object Type Structure, select the SimpleOnOffMotor object.

2. Select the newly created graphic element LorryElement as shown in Creating 
Graphic Element Aspects.

3. Right-click this aspect and select Edit from the context menu. This opens the 
Graphics Builder.

4. Drag and drop the Symbol Factory Symbol (Toolboxes > Special) into the 
edit panel of the Graphics Builder. 

5. Right-click the symbol and select Edit from the context menu as shown in 
Figure 2.

Figure 1. Create Graphic Element Aspect
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This displays the Symbol factory properties dialog as shown in Figure 3.

Figure 2. Editing a Symbol Factory Symbol
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6. Select the required symbol. Click Apply and then click OK to save the 

changes.

7. In the Properties window of this symbol, click  corresponding to the Visible 
property to open the Expression Editor.

8. Write the following expression to connect the Visible property to the binary 
process signal. This expression is used to display the symbol only if the signal 
value is True.

Figure 3. Symbol Factory Properties
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if Motor_ON:Value then
    True

else 
  False

For more information on using the Expression Editor, refer to System 800xA, 
Engineering, Process Graphics User Guide (3BSE049230*).

9. Click OK to save the expression.

Adding Error Indicator

The ErrorIndicator is used to indicate the quality of subscribed data, when it reaches 
the limits defined by the OPC. If the ErrorIndicator has any property configured to a 
dynamic expression value, the runtime mode displays the actual representation. The 
DataQuality property of the ErrorIndicator controls the quality of subscribed data.

Drag and drop the Error Indicator (Toolboxes > Graphic Primitives) into the edit 
panel of the Graphics Builder.

Figure 4. Adding an Error Indicator to the graphic element
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10. Write the following expression to connect the DataQuality property to the 
binary process signal. This expression is used to display the data quality based 
on the signal value.

if Motor_ON:LowLimit < 10 then
    Bad

else 
  Good

For more information on using the Expression Editor, refer to System 800xA, 
Engineering, Process Graphics User Guide (3BSE049230*).

11. Click OK to save the expression.

Creating Tank Element

The primitives required for building a tank are available in Toolboxes > Shapes. 
This includes the following primitives:

– TankBody - This is used as the body of tank object.

– TankBottom - This is used as the bottom of tank object.

– TankCone - This is used as the top of tank object.

– TankNeck - This is used as the bottom of tank object.

– TankTop - This is used as the top of tank object.

Execute the following steps to create a tank element.

1. Open the Graphics Builder. For more information on editing a graphic aspect, 
refer to Editing a Graphic Element in Graphics Builder.

2. Drag and drop Tank Body, Tank Top, and Tank Bottom primitives (Toolbox 
> Shapes) into the edit panel.

3. Move and resize the primitives as shown in Figure 5.

4. Press SHIFT and click Tank Body, Tank Top, and Tank Bottom to select the 
primitives.

5. Select Format > Group to group the primitives.
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Use the handles as shown in Figure 6 to resize the tank elements if required. In 
the Properties window, you can also modify the Height and Width properties 
to resize the shapes.

Figure 5. PLC Subelements Tank Element
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Adding a Bar to Tank Element

Drag and drop Bar (Toolboxes > Graphic Primitives) into the edit panel of the 
Graphics Builder. 

Place the primitive within the tank element as shown in Figure 7.

Figure 6. Resizing the tank elements

Figure 7. Bar Graph added to Tank Element
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Receiving live data to the Tank Element

1. Select the Bar primitive.

2. In the Properties window, click  corresponding to the BarValue property. 
This opens the Expression Editor.

3. Write the following expression.

Motor_ON:HighLimit

The value of the bar will be based on the value of HighLimit property of the 
signal.

Creating Valve Element

1. In the Object Type Structure, select a Valve object type from Plant&Mill > 
Valves.

2. Right-click the object type and select New Aspect from the context menu.

3. Select AlarmStatus aspect category.

4. Click Create. The AlarmStatus aspect is required to propagate the alarm 
information to the object type.

5. Right-click this object type and select New Aspect.

6. Select Graphic Element PG2 aspect category.

7. Enter a name for the graphic element (For example, Valve Element) and click 
Create.

8. Right-click the element and select Edit from the context menu. This opens the 
Graphics Builder.

9. Drag and drop the Valve primitive (Toolboxes > Standard Symbols) and 
Alarm Symbol primitive (Toolboxes > Graphic Primitives) into the edit 
panel of the Graphics Builder.

10. Drag and drop the Reduced Icon primitive (Toolboxes > Standard Symbols) 
into the edit panel of the Graphics Builder. 

Do not rename the AlarmStatus aspect.
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11. In the Properties window, set the OpNote property to True to display the 
operator message.

12. Select the Valve primitive.

13. In the Properties window, set the CfgOrientation to Vertical or Horizontal to 
set the direction of the valve.

14. In the Properties window, click  corresponding to the Open property. This 
opens the Expression Editor. 

15. Write the following expression to connect the Open property to the binary 
process signal. This expression is used to control the opening and closing of 
this valve.

Figure 8. Creating a Valve Element
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if Motor_ON:HighLimit > 50 then
    True

else 
  False

16. Click OK to save the expression.

17. Select the AlarmControl primitive. 

18. In the Properties window, click  corresponding to the AlarmState property. 
This opens the Expression Editor. 

19. Write the following expression to connect the AlarmState property to the 
AlarmStatus aspect of the object type.

SimpleOnOffMotor:AlarmState

20. Click OK to save the expression.

21. Select File > Save to save the graphic aspect.

Adding PLC Connect Graphic Elements to Graphic 
Displays

1. In the Functional Structure, right-click an object and select New Aspect from 
the context menu.

2. Select the Graphic Display PG2 aspect category.

3. Enter a name for the graphic display (For example, Delivery Overview) and 
click Create.

4. Right-click the graphic display and select Edit from the context menu. This 
opens the Graphics Builder.

5. Select View > Element Explorer to open the element explorer.

For more information on using the Expression Editor, refer to System 800xA -
Engineering, Process Graphics User Guide (3BSE049230*).

Execute the above procedure to configure a motor (Toolboxes > Classic 
Symbols), a three way valve (Toolboxes > Classic Symbols) or any other 
symbol required.
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6. Browse to the required object type and select the PLC Connect Process Object.

7. Double-click the element to add it to the edit panel of the Graphics Builder as 
shown in Figure 9.

8. Select File > Save to save the graphic aspect.

Faceplate
Faceplates are used for monitoring and controlling the process. They are invoked 
by:

• Clicking on a graphic element placed on a graphic display as shown in 
Figure 10.

Figure 9.  Inserting PLC Connect Element in Graphic Display
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• Right-clicking Faceplate aspect in the Plant Explorer workplace and select one 
of the required faceplate view from the context menu as shown in Figure 11.

Figure 10. Graphic Display
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User Interface

Faceplate appears as shown in Figure 12.

Figure 11. Faceplate aspect available for an object

Figure 12. Faceplate view
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The visible components of the faceplate interface can be broadly classified into 
three areas:

• Header Area

• Element Area

• Button Area

Each of these areas contain several operable elements that configure, modify or 
display aspects of the faceplate.

Header Area

Header area comprises:

Object lock

Object Locking is used in environments where several operator workplaces control 
the same objects. Only one operator can use the Object Lock function to operate the 
objects. The Lock Control button is optional. The faceplate framework reserves 
space for it in the header area.

It provides the option to control the function manually or automatically. If Autolock 
is enabled, the object will be locked after the faceplate is opened. When the 
faceplate is closed, the Lock Status will revert to unlocked. 

If the Object Lock function is controlled manually, you can lock an object by 
clicking the Object Lock button (see Figure 12). If the lock required option is 
enabled, all buttons and commands will be disabled till you click Object Lock 
button.

To switch between Autolock and manual lock, change the FaceplateAutoLockObject 
profile value in the Graphics Profile Values user profile.

If the object is locked by another operator, operation is not possible until the lock is 
released. To release an object lock, the operator owning the lock can manually 
unlock it, or the operator can close the faceplate. The object lock may time out after 
a default time of four minutes. A privileged user can also break the object lock 
through the context menu of Lock Control.

For more information on Faceplate refer System 800xA - Engineering, Process 
Graphics User Guide (3BSE049230*)
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Object Name and Description

This displays the name and description of the object, for example, LI330 - Level 
Tank 1(see Figure 12). Object name and object description is optional because of 
user profile setting.

Alarm Control

Alarm Control button indicates the alarm state of the object, and allows 
acknowledgement of alarms. The alarm control is a graphic element aspect. Alarm 
Control details are displayed in the header area of the faceplate. Alarm button 
configuration is done using the AlarmControl aspect.

Table 2 displays the most common alarm indicators.
.

Table 2. Alarm Indicators 

Icon Description

Alarm is active and acknowledged.

Alarm is active, but not acknowledged.

Indicates illegal alarm configuration.

Alarm is automatically disabled by the 
system.

Alarm disabled by a user.

Alarm is idle, that is there are no alarms.
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 Configuring Faceplate
Configuration is done using the Config view. Only the user having the privileges of 
an Application Engineer is allowed to configure faceplates.

Alarm is neither active, nor acknowledged.

Hidden Alarm.  
A white rectangle covering an alarm symbol, 
shows that there are hidden alarms for the 
object.

Shelved Alarm.  
A white circle appearing to the right of the 
alarm symbol shows that there are shelved 
alarms for the object.

If the faceplate is Inherited, changes can be made only in the object type.

Table 2. Alarm Indicators (Continued)

Icon Description
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The Config view contains the following:

• Layout Tab - configuration of the faceplate geometry.

• Header Tab - configuration of the object lock control and alarm control.

• Indicators Tab - configuration of the Status and Navigation bar.

• Buttons Tab - configuration of the Button area.

• Element Tab - configuration of the faceplate element area.

• Online Help Tab - configuration of the help files.

• Approval or unapproval of faceplates.

Figure 13. Open Config View
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Layout Tab

Layout tab contains information on the runtime view that should be displayed and 
the geometrical layout of the views. The faceplate view is mandatory.

Faceplate view is the default runtime view that is launched when an operator clicks 
on a graphic element in a graphic display. Once the faceplate is opened this can be 
changed using the View selection buttons.

You can also select the orientation of the faceplate element area.

The default size of the faceplate element aspects are designed using preconfigured 
values of the faceplate width and height.

Figure 14 shows the configurable parameters in the Layout tab.

The update rate for subscribed properties for indicators and buttons are initially set 
to 1 second. You can configure a new value (in milliseconds) in Update Rate.

Enable/disable of faceplate views requires a restart of the workplace and Operator 
Workplace.

Figure 14. Layout Tab with Default Values
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Header Tab

Header tab is used to configure the settings for Lock button and Alarm button. 
These configuration settings are also performance related in case of a search 
required for finding the Alarm Control or Lock Control aspects.

Figure 15. Header Tab
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Table 3 describes the fields present in this tab.

Table 3. Header Tab 

Field Description

Lock button policy

This search order is executed sequentially. For example, first the 
LockControl aspect present on the invocation object is used if it exists. 
Otherwise, the LOCK property on the invocation object is used if exists, 
and so on. The Default search order appears by default in the drop-down 
list.

Lock button policy Select the following from the drop-down list. 
Options include:

- Override Standard LockControl

- Legacy Lock Handling

- Standard LockControl

- No Lock button

Override Standard 
LockControl

Uses the LockControl aspect present on 
invocation object, if it exists.

Legacy Lock 
Handling

Used if the LOCK property exists on the 
invocation object.

Standard 
LockControl

Uses the LockControl aspect in the Graphics 
Structure > Graphic Tools VB6 > Special.

No Lock button No lock button is used.

Prefer PG2 version of 
LockControl

Select to use the PG2 lock control aspect if it 
exists on the object. This is used only if the 
object includes both VBPG and PG2 faceplates.

This field is enabled when Override Standard 
LockControl is selected.

Alarm button policy

This search order is executed sequentially. For example, first the 
AlarmControl aspect present on the invocation object is used if it exists. 
Otherwise, the no alarm button is used.
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 Indicators Tab

Indicators tab is used to configure the indicators and aspect links to be displayed in 
the status and navigation area of the faceplate. You can decides the position to 
display them, depending on the selected view.

Alarm button policy Select the following from the drop-down list. 
Options include:

- Override Standard AlarmControl

- No Lock button

- Standard AlarmControl

Override Standard 
AlarmControl

Uses the AlarmControl aspect present on the 
invocation object, if it exists.

No alarm button No alarm button is used.

Standard 
AlarmControl

Uses AlarmControl aspect in the Graphics 
Structure > Graphics Tools > Special.

Prefer PG2 version of 
AlarmControl

Select this to use the PG2 alarm control aspect 
if it exists on the object. This is used only if the 
object includes both VBPG and PG2 faceplates.

Table 3. Header Tab (Continued)

Field Description
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Configuring Indicators

Table 4 displays the configurable parameters in the Indicators tab that affect the 
Status and Navigation area in the faceplate.

Figure 16. Indicators Tab

Table 4. Indicators Tab 

Parameter Description

Icons/Labels Indicates the list of Icons/Labels that represent the result of 
object properties that are subscribed and specified as 
expressions.

Expression Indicates the calculation returning an integer value. 

The result must be in the range from 0 to number of 
Icon/Labels configured - 1.
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To configure indicators, do the following:

1. Click Icons/Labels column. Labels dialog box appears as shown in Figure 17.

2. Add the number of icons or labels to be used for each indicator. The values in 
Index is numbered as 0, 1, 2 to N-1.

3. Click the column at the extreme left to select an entire indicator row. You can 
delete the selected row or order the rows using the spin buttons. 

Reduced pos Specify the position of the indicator in the Reduced view. 
Position starts from 1 and is counted from left to right with 
increasing numbers.

0 = Not used by this view.

The exact position of the indicator depends on No. of 
indicators per row, and No. of indicator rows

Faceplate pos Indicates the position within the faceplate view.

Extended pos Indicates the position within the extended view.

Table 4. Indicators Tab (Continued)

Parameter Description
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Indicators are positioned to the left in the Status and Navigation area.

For example, to configure the first icon/label to be displayed if the value of a 
property LIMIT is below 50, and the second icon/label to be displayed if the value of 
the same property is above 50, set the expression for the indicator as:

iif($'.:Control Connection:LIMIT' < 50,0,1)

Figure 18 displays an indicator if the expression for the indicator is wrongly set, or 
the expression or expression value causes an error condition.

Figure 17. Configuration of Icons/Labels

Figure 18. Faceplate with Indicator during an Error Condition

Index 0

Index 1
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Configuring Aspect Links

Table 5 displays the configurable parameters for the aspect links. Aspect links are 
positioned to the right in the Status and Navigation area. An aspect link is a button 
used as a shortcut to call up any type of aspect as an overlap window.

To configure aspect links, do the following:

1. Select Object column. Select Object Dialog window appears.

2. Select the required object from this screen and click OK. If the faceplate is 
configured in the Object Type Structure, you should select only the objects 
belonging to the same object type.

3. Click Icon/Label column, the Add Label or Icon screen appears. 

Table 5. Aspect Links 

Parameter Description

Object Indicates the object of the aspect to be displayed. 

Aspect Indicates the aspect to be displayed as an overlap window. 

View Indicates the view for the selected aspect. If a view is 
selected, the link cannot have a verb.

AspectVerb Indicates the verb connected to the aspect. If a verb is 
selected the link can have no view.

Icon/Label Indicates the label, icon or aspect icon to be displayed on 
the aspect link.

Label color Indicates the text color used for the label.

Reduced pos Indicates the position within the Reduced view. Refer 
Table 4 for more information.

Faceplate pos Indicates the position within the faceplate view.

Extended pos Indicates the position within the extended view.

FontSize Indicates the size of the text.
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4. Select Use aspect icon to get the aspect icon as a graphical representation of 
the button, or select an icon or specify a label to be displayed.

Refer to System 800xA - Operations, Operator Workplace Configuration 
(3BSE030322*) for more information on Global Verbs.
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Buttons Tab

Buttons tab allows you to configure the buttons to be used in the Buttons area of the 
faceplate. The behavior of the buttons is specified by the Action column and the 
default value is SystemDefault.

Table 6 displays the configurable parameters present in this tab.

Figure 19. Buttons Tab
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Table 6. Buttons Tab

Parameter Description

Object Indicates the object of the property to be used, for example, 
binary.

Icon/Labels Indicates the label or icon to be used as caption for

example,  (stop.icon)

Property name Indicates the object property to which the value should be 
written when the button is clicked, for example, Value - 
Binary PCA

Property type Indicates the data type of the selected object property 
(ReadOnly). This field gets populated depending on the 
Property Name selected.

Property value Indicates the value to be written to the property while 
clicking the button, for example, True.

Enabled Indicates an expression specifying whether the button is 
enabled, dimmed or invisible. No expression means that the 
button is always enabled. [0 = dimmed, 1 = enabled, 2 = 
invisible].

For example, iif(“$./LOCK:Value” = 3, 
if(“$./Binary:Value:Value,True,False),False
)

Tooltip text Indicates the tooltip to be displayed for the button.

Reduced pos Indicates the position within the Reduced view.

Refer to Table 4 for more information.

Faceplate pos Indicates the position within the faceplate view.

Extended pos Indicates the position within the extended view.

Action Sets direct or applied action for the button. 
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More than one button can have the same position. In this case, only one of the 
overlapping buttons should be visible (that is, only one button can have the 
expression value of 1 or 0).

Select Reduced, Faceplate, or Extended in Apply present, to activate the Apply 
button for the different views.

Element Tab

Element tab is used to configure the faceplate element area. Aspects can be put 
directly, or can be organized in tab groups.  

Table 7 describes columns present in this tab.

The Apply button is always located to the right of the button area and cannot be 
repositioned.

Figure 20. Elements tab
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 To configure faceplate elements, do the following:

1. Faceplate Element aspects are designed to be used here, but any aspect type can 
be used. A faceplate element aspect has a default size to fit within the faceplate 
view. 

2. Click Aspect column to select the aspect to be represented as a tab in the 
faceplate.

Table 7. Element Tab

Parameter Description

Object Indicates the object of the aspect to be used.

Aspect Indicates the faceplate element aspect (or other aspect) 
placed in the faceplate element area.

View Indicates the aspect view for the selected aspect.

Tab group Indicates the tab group identity as a string, for example, as 
a numeric value 0,1, and so on. The group identity is not 
shown anywhere.

Caption Indicates the name of the tab.

User Roles Indicates the user group having access rights for the tab.
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3. Select a view to be displayed, in the View column.

4. Enter an identifying string representing the identity of a tab group in the Tab 
Group column. A simple number is suitable because the identification string is 
not visible to any operator. For example, enter 1 for the first tab group, enter 2 
for the second and so on. The location of the tabs in a group is defined by the 
order among them and can be ordered using the spin buttons.

Figure 21. Aspect drop-down menu
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5. Click Caption column. Caption dialog box appears.

6. Type name for the tabs and click OK.

Figure 22. Configuration of Two Tab Groups

Figure 23. The Two Tabs as Seen in the Faceplate
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 7. In User Roles column, define the user group having the privilege to access the 
tab. Only the users belonging to the defined group can view the tab.

Figure 24. Caption dialog box

Figure 25. Defining User Role for Faceplate Tabs
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Online Help Tab

Online Help tab defines the help text to be displayed on pressing the F1 key from 
the faceplate.
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Section 3 Alarm and Event Handling

PLC Connect Specific Alarm and Event Lists
PLC Connect supplies three basic types of alarm and event lists. These lists are 
filtered lists configured to show a selection of the alarms and events:

• PLC Alarm List

• Control Blocked Signals List

• Forced Signals List 

For more information on alarm and event handling, refer to the System 800xA - 
System Extended Operation (3BSE036904*).
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PLC Alarm List

This list shows alarms, including alarms disabled by an operator. Figure 26 shows 
an example.  

Figure 26. PLC Alarm List with Disabled Alarms
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Table 8 describes the columns present in this list.

Control Blocked Signals List

This list shows control blocked signals. These are manually controllable signals that 
are disabled. The values of a control blocked signal cannot be changed by an 

Table 8. PLC Alarm List

Column Description

Ack Indicates whether the alarm is 
acknowledged or not. You can also 
acknowledge an alarm in this column.

Severity Indicates the priority of the alarm.

Event Time Indicates the time when the alarm was 
generated. If the alarm is disabled, this 
column displays the time when the 
alarm was disabled.

Object Name Indicates the name of the process object 
and signal.

Condition Indicates the relative name of the signal. 
For integer and real signals, the name of 
the limiter that triggered the alarm is 
appended. 

If the signal’s default condition name is 
overridden with another name then 
Condition displays the new name 
instead of relative name.

Message 
Description

Indicates the event text.

Auto Dis Indicates whether the alarm is auto 
disabled or not.

Class Indicates the class of the alarm
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operator. Figure 27 shows an example.

Table 9 describes the columns present in this list.

Forced Signals List

This list shows forced signals. Forced signals are signals whose values are 
temporarily forced to a certain value, that is, the signal values appear to be constant 
regardless of the actual process values. Figure 28 shows an example.

Figure 27. List of Control Blocked Signals

Table 9. Control Blocked Signals List

Column Description

Event Time Indicates the time when the control 
signal was disabled.

Severity Indicates the name of the process object 
and signal.

Figure 28. List of Forced Signals
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Table 10 describes the columns present in this list.

Using the Lists

To enable a disabled alarm, enable a control signal, or remove the forcing of a signal 
value:

1. Right-click the signal row.

2. Select Enable selected or Enable object from the context menu.

Table 10. Forced Signals List

Column Description

Event Time Indicates the time when the signal was 
forced.

Object Name Indicates the name of the process object 
and signal.

Current Value Indicates the value that the signal is 
forced to.
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Section 4  Dialed Communication 

This section describes dialed communication:

• Dial Panel on page 55 is used to control the communication with a single 
remote controller.

• Dial Supervisor on page 58 is used to supervise and control the communication 
in a whole control network.

What is Dialed Communication?

Remote controllers can be dialed up and communicated with via Comli or Modbus 
(Serial), that is, live process data and historic information can be collected to a 
server. For Comli, time marked events can be collected too. Provided are:

• Manually order calls, with and without a time limit.

• Permanent calls.

• Scheduled (cyclic) calls for collection of historic data.

Incoming connections are also supported, where controllers can call up the server in 
the case of an alarm and so on.

Dial Panel
The Dial Panel aspect as shown in Figure 29 is an aspect of Dialed Controller in 
Control Structure. It contains the basic functions to initiate, monitor and terminate 
calls to a remote controller. 

License information: The dial manager is part of the PLC Connect Dialed 
communication functionality which requires a separate license to run.
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To access the aspect:

1. Go to Control Structure and select a dialed controller.

2. In the Aspect List area, select Dial Panel aspect. Use it to initiate, monitor and 
terminate calls.

3. If desired, repeat above steps for other dialed controller. 

Table 11 and Table 12 describes the fields and buttons present in this tab.  

Figure 29. Dial Panel Aspect

There can be aspect links to a Dial Panel aspect in process graphic displays. If 
present, you can also click such a link to access the aspect.

Table 11. Dial Panel Aspect

Field Description

Type of call

Manual Close Select this type of call to keep the connection open until 
the call is manually terminated. If an error occurs 
whereby the connection is terminated, it will remain 
terminated i.e., the connection will not be automatically 
re-established.

Time Limit (minutes) Select this type of call if the connection is to be 
terminated automatically after a certain amount of time. 
The call can also be manually disconnected at any time.
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Select the Type of Call

Select the type of call by selecting either:

• Manual Close.

• Time Limit [minutes]. Enter the time limit in minutes in the text box to the 
right.

Initiate/Terminate a Call

The button in the Dial Panel will be labeled Dial when no connection is established, 
and Hang up when a connection is established:

• When you have selected the type of call, click Dial to initiate the call.

• Click Hang up to terminate the call.

Table 12. Dial Panel Aspect - Button

Button Function

Dial/ Hang up Dial is labeled when no connection is established. Click 
to initiate a call

Hang up is labeled when connection is established. Click 
to terminate a call.
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View Call Status

A status indication as shown in Table 13 displays the basic status of a manual call, 
while the status bar of the Dial Panel displays status information for both types of 
calls, for example: initiating, connected, disconnecting, disconnected, and so on. 

Dial Supervisor
The Dial Supervisor aspect as shown in Figure 30 is an aspect of Generic Control 
Network in Control Structure. It contains functions to initiate, monitor (supervise) 
and terminate calls to remote controllers in a specific control network. 

To access the aspect:

1. Go to Control Structure and select a relevant Generic Control Network object.

2. In the Aspect List area, select Dial Supervisor aspect as shown in Figure 30.

Table 13. Call Status Indication 

Appearance Description

The indication is dimmed when no 
connection is established.

The indication is red when a connection 
has failed.

The indication is yellow when a call is in 
progress.

The indication is green when a 
connection to a controller is established.
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3. If desired, repeat the above steps for other control network. 

Figure 30. Dial Supervisor Aspect

There can be aspect links to a Dial Supervisor aspect in process graphic displays. 
If present, you can also click such a link to access the aspect.
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Initiate Calls Tab

This tab as shown in Figure 31 is used to initiate, monitor and terminate calls to 
remote controllers. 

Figure 31. Dial Supervisor aspect - Initiate Calls
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Table 14 and Table 15 describes the fields and buttons present in this tab.  

Table 14. Initiate Calls 

Field Description

Type of call

Controller Select a controller from the drop-down list and select the 
type of call from the options below.

Manual Close Select this type of call to keep the connection open until 
the call is manually terminated. If an error occurs 
whereby the connection is terminated, it will remain 
terminated i.e., the connection will not be automatically 
re-established.

Permanent Select this type of call to keep the connection open 
permanently. If an error occurs whereby the connection 
is terminated, attempts will automatically be made to re-
establish the connection. These attempts will continue 
until the connection is re-established.

Time Limit Select this type of call if the connection is to be 
terminated automatically after a certain amount of time. 
The call can also be manually disconnected at any time. 

Specify the time limit in minutes.

History: Single 
Controller

Select this type of call to collect historic data from a 
single controller. The option to keep text files after import 
is used for troubleshooting purposes only.

Keep text files after 
import

Select the check box if you want to retain the text files 
after import.

Call Status

Displays status information when there is an active call to the selected controller.

Time Connected Indicates the time (HH:MM:SS) since when the call is 
active.

Time Remaining Indicates the time remaining for the call to terminate.

Time Status Table indicates how the call is progressing.
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 Cyclic Call

Cyclic calls are used to automatically collect historic data from a number of 
controllers at scheduled times. For example, at 3 PM the historic data can be 
scheduled to be collected from controllers A and B, while at 5 PM it can be 
scheduled to be collected from controllers C and D. Sometimes this collection 
cannot be done due to errors, for example, if one or more of the controllers 
scheduled to be called at a certain time are down at the call time. If such an error 
occurs, you can manually initiate a cyclic call.

In the Collect History Data area, select a scheduled call time from the drop-down 
list. All controllers scheduled to be called at the selected time will be called when 
the call is initiated.

The option to keep text files after import is used for troubleshooting purposes only.

Initiate a Call

When you have specified a call, click the relevant Dial button under the Initiate calls 
tab.

Collect History Data

All controllers 
scheduled at

Select the scheduled call time from the drop-down list.

All controllers scheduled to be called at the selected 
time will be called when the call is initiated.

Table 15. Initiate Calls - Button

Button Function

Dial (for Type of Call) Click to initiate call to the selected controller.

Hang Up Click to terminate an active call to the selected controller.

Dial (for Collect History 
Data)

Click to initiate the selected cyclic call. 

Table 14. Initiate Calls (Continued)

Field Description
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View Call Status

Under the Initiate calls tab, the Call Status area shows call status information when 
there is an active call to the controller selected from the Controller drop-down list.

The Time connected box shows the time the call has been active in hours, minutes 
and seconds, while the Time remaining box shows the time remaining until the call 
is terminated.

The table to the right shows how the call is proceeding.

Under the Line status tab a table with information on each active call is shown.

Line Status Tab

This tab as shown in Figure 33 is used to enable, disable, monitor and terminate 
calls to remote controllers. The Call Status area displays call status information 
when there is an active call to the controller selected from the Controller drop-
down list.

Figure 32. Dial Supervisor aspect - Line Status
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Table 16 and Table 17 describes the columns and buttons present in this tab.

Terminate/Disable a Call

Under the Initiate Calls tab, the Call Status area shows call status information when 
there is an active call to the controller selected from the Controller drop-down list. 
To terminate that active call, click Hang up in the Type of call area.

Table 16. Line Status

Column Description

Line Indicates the line number.

Controller Indicates the controller selected in Initiate Calls tab.

Call Type Indicates the call type selected in Initiate Calls tab.

Connect Time Indicates the time when there is an active call.

Status Indicates the active call status.

Table 17. Line Status - Buttons

Button Function

Hang Up Cyclic Click to terminate a cyclic call i.e., a call for which the 
Call Type is Cyclic

Hang Up Click to terminate a normal call.

Disable Line Click to disable line i.e., to avoid using the line for 
outgoing calls. For example, when a line behaves badly.

Lines can also be disabled by the system.

Enable Line Click to enable a disabled line.
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Under the Line Status tab as shown in Figure 31, a table with information on each 
active call is listed. Select a connection by selecting its name in the Line column, 
and:

• Click Hang up Cyclic to terminate a cyclic call, that is, a call for which the 
Call Type column contains the word cyclic.

• Click Hang up to terminate a normal call.

• Click Disable Line to disable the line, that is, to avoid using the line for 
outgoing calls, for example, when a line behaves badly. Lines can also be 
disabled by the system.

• Click Enable Line to enable a disabled line.

Figure 33. Dial Supervisor aspect - Line Status
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